User’s Guide to STAT
The SHADWELL Test Analysis Tool (Version 2.0)

JOHN B. HOOVER
Navy Technology Center for Safety and Survivability
Chemistry Division

February 29, 2008
The SHADWELL Test Analysis Tool, originally developed to aid in the analysis of large-scale fire test data, has been updated. The new version removes the dependency on proprietary, third-party software and adds support for several new data input formats, including SHADWELL LabVIEW test data and the Fire and Smoke Simulator (FSSIM) fire model output. Methods are provided for definition of data channels, selection of data based on instrument type and location, filtering of data using various criteria and processing of the remaining data.
CONTENTS

PART I  PURPOSE AND CAPABILITIES ................................................................. 1

1.0  INTRODUCTION ....................................................................................... 1
   1.1  Data Sources ....................................................................................... 1
   1.2  The SHADWELL Test Analysis Tool ................................................... 2
   1.3  System Requirements ....................................................................... 2
   1.4  Installation ......................................................................................... 2

2.0  OVERVIEW ............................................................................................. 3
   2.1  Importing Data .................................................................................. 6
       2.1.1 Creating a New Data Set .............................................................. 6
       2.1.2 Appending to a Data Set ............................................................. 7
   2.2  Defining Test Configurations ............................................................. 7
       2.2.1 Editing Lists ............................................................................... 7
       2.2.2 Configuring Instruments ............................................................. 8
       2.2.3 Configuring Channels ................................................................. 8
   2.3  Processing Data .................................................................................. 9
       2.3.1 Selecting Data ............................................................................ 11
       2.3.2 Filtering Data ............................................................................. 11
       2.3.3 Normalizing Data ............................................................... 11
       2.3.4 Smoothing Data .............................................................. 12
   2.4  Data Output .................................................................................... 12
   2.5  Example Data ............................................................................... 12

PART II  MENU COMMANDS ............................................................................. 13

3.0  STAT MENU (Macintosh only) ............................................................... 13
   3.1  About STAT .................................................................................... 13
   3.2  Quit STAT ....................................................................................... 13

4.0  FILE MENU .......................................................................................... 14
   4.1  New Data Set... ............................................................................... 15
   4.2  Append Data Set... .......................................................................... 16
   4.3  Open Data Set... ............................................................................. 16
   4.4  Close ............................................................................................ 16
   4.5  Save ............................................................................................ 16
   4.6  Save As... .................................................................................... 16
   4.7  Export Data... ............................................................................. 17
   4.8  Exit (Windows only) .................................................................... 17

5.0  EDIT MENU ........................................................................................... 18
   5.1  Clear Selection .............................................................................. 18
6.0 DATA MENU .................................................................................................................. 18
  6.1 Select............................................................................................................................. 18
  6.2 Filter.............................................................................................................................. 19
  6.3 Clear Filter..................................................................................................................... 22
  6.4 Normalize....................................................................................................................... 22
  6.5 Smooth......................................................................................................................... 23

7.0 CONFIGURATION MENU ............................................................................................ 24
  7.1 Edit Lists....................................................................................................................... 24
  7.2 Configure Instruments................................................................................................. 25
  7.3 Configure Channels...................................................................................................... 26
  7.4 Import Configuration.................................................................................................... 27
  7.5 Export Configuration..................................................................................................... 28

8.0 HELP MENU .................................................................................................................. 28
  8.1 About STAT.................................................................................................................. 28

9.0 REFERENCES .................................................................................................................. 28

ACKNOWLEDGMENTS ...................................................................................................... 29

APPENDIX A STAT 2.0 Distribution CDROM ................................................................. A-1
PART I PURPOSE AND CAPABILITIES

This document is composed of two parts. Part I discusses the history and purpose of the SHADWELL Test Analysis Tool (STAT), provides information regarding system requirements and installation and gives an overview of the program capabilities. A sample set of test data is included on the distribution CDROM for those who would like to follow the discussion. Part II presents a more in-depth explanation, including the details of all STAT menus and dialog boxes.

1.0 INTRODUCTION

STAT was originally designed as a tool to assist in the analysis of data from large-scale tests conducted on board the ex-USS SHADWELL damage control test platform. STAT version 1.0 [1] was written in 1998 and proved to be very useful over a period of several years. It was written in Microsoft’s Visual Basic for Applications (VBA) programming language as an add-in for Excel 5 and was critically dependent on Excel for services such as file storage, printing and data display. Unfortunately, it was found that, with each new version of Excel, VBA was changed in ways that broke the tool and required significant effort to repair. It rapidly became apparent that it was not feasible to continue this dependence on VBA/Excel features over which we had no control.

As a result, STAT version 2.0 has been completely rewritten, using Real Software’s REALbasic programming language. This removed the dependence on Excel and accelerated the software since it is now a compiled application rather than a script running within another application. However, this also meant that all of the services previously provided by Excel had to be provided within the application. As a result, some of the features of STAT 1.0, such as the ability to print a page, have not yet been implemented in the new version. It is hoped that it will be possible to restore these missing features, and add new capabilities, in future releases.

One new feature that has been added is the ability to import data in several different formats. At the time that STAT 1.0 was written, the ex-USS SHADWELL data system was based on a MassComp computer, running custom software and data acquisition hardware. The MassComp system is being phased out and replaced with networked National Instruments LabVIEW data acquisition modules, controlled by LabVIEW software running on standard personal computers. Also, in recent years, it has become more common to use numerical fire modeling to simulate tests. As a result, STAT has been revised to support analysis of some computer-generated outputs, as well as experimental data in several formats. The STAT disk file has also been changed from the Excel spreadsheet format to a relational database format based on the SQLite\(^1\) database engine.

1.1 Data Sources

The original version of STAT imported only a format produced by translation of the MassComp binary data files into text files during post-processing. STAT version 2.0 still includes the original format (now labeled “MassComp (translated)”) but adds another MassComp format (“MassComp (tab-delimited)”), which is produced by a newer, Excel-based, post-processing

\(^{1}\) SQLite is an open source database. Additional information may be obtained from www.sqlite.org.
tool. A format for LabVIEW test data and the Mississippi State University viewer format [2], produced by the Fire and Smoke Simulator (FSSIM) fire model, have also been added. These are labeled ‘LabVIEW’ and “MSU GUI” in the format list.

1.2 The SHADWELL Test Analysis Tool

Analysis of large-scale fire data, whether from actual tests or computer simulations, is usually very labor intensive. Typically, the following steps are needed:

a. selection of specific data types (e.g., air temperatures or pressures) in specific compartments;
b. removal of “bad” data (for example, open or shorted sensors);
c. filtering of noise;
d. correction of zero-offset errors in each channel;
e. data smoothing; and
f. calculation of means and standard deviations, if there are multiple channels.

Historically, most of the above has been done manually; STAT was written to aid in data analysis by automating many of these processes. It permits definition of sensor types, locations, and instrument configurations, provides methods for selection of data meeting specified criteria and includes functions for processing those data.

1.3 System Requirements

STAT currently runs on Macintosh and Windows computers. Operating systems that have been tested include Macintosh OS X 10.4 (PowerPC and Intel processors) and Windows 2000; although not tested, it is expected that it will run on OS X 10.3, Windows XP and Vista. Any modern computer that is capable of running one of the above operating systems should have more than enough power for STAT. The application is relatively small (6 MB for Windows and 12 MB for Macintosh²).

1.4 Installation

It is recommended that the STAT application file be copied to the computer hard drive but, if necessary, it can be executed directly from the CD. Note that STAT creates a hidden temporary file when a data set is created or opened. Therefore, it is necessary that there be enough free disk space to store the data and that the user have write access to the temporary directory (folder). The amount of space required will, of course, depend on the size of the data set — the initial file size

² The Macintosh version is twice the size because it includes both PowerPC and Intel code — in effect, it is two applications in one.
will typically be about 20% larger than the original text file, but will grow as processed data are added.

2.0 OVERVIEW

This section provides an overview of the functionality of the STAT application. We consider, in very general terms, the process of loading data, setting up the data configuration, processing the data and exporting the results. Each of these is discussed in the following sections. More detailed descriptions, including screen captures of the various menus and dialogs, may be found in Part II of this report.

Most functions in STAT include some degree of error trapping, with messages that explain in which method, function or subroutine the error occurred and give a hint as to the cause. Please report these messages, along with brief descriptions of what triggered the errors, so that they may be fixed in future versions.

Figure 1 shows the main data window with its associated controls. Data are organized in pages, which are selected using the page selector popup menu in the lower left corner. Initially, a single page (titled “Raw Data”) is created from the imported data; additional pages (having user-assigned names) are added during data processing. The top two rows contain column headings, with the top row being the column labels that were imported as part of the data. For some import formats, the second row displays the units of measurement.

The triangular control in the upper right corner controls the display of a context-sensitive information window, illustrated in Figure 2. This window shows the name of the current data page, the test program title, test date, series and test number and ignition time and the name(s) and format(s) of the original data file(s). If a column has been selected (by clicking within it), information regarding that column also appears. This includes the instrument type and compartment and the page from which the data were extracted (“<import from file>” indicates that the data came from the original file and has not been processed).

Note that, due to differences in the features and conventions of the Macintosh and Windows operating systems, some of the functions do not behave exactly the same way on the two platforms. The most obvious differences are as follows:

a. Windows programs always display a window, which contains the application’s menu bar, even when there is no data. In contrast, Macintosh programs put the menu bar at the top of the main display and normally do not show a window until a file has been created or opened. This difference will be seen when the application is first launched.

b. The Macintosh operating system has the concepts of “sheet” and “drawer” windows which are associated with a specific data window and are used to display auxiliary information. These windows drop down from the main window.

---

3 These are relatively recent additions to the Macintosh user interface and may not appear if STAT is run on older versions of Mac OS X.
title bar (for sheet windows) or slide out from the main window frame (for drawer windows) and retract when no longer needed. The Macintosh version of STAT implements most dialog boxes as sheet windows; the information window is a drawer. On Windows systems, the corresponding dialogs are implemented as stand-alone windows.

![Figure 1. STAT Data Window](image)

The STAT main window displays the initially imported data on this page (“Raw Data”) and appends additional pages as data processing progresses. Pages may be selected using the popup menu in the lower left corner. The control in the upper right shows and hides the information window.
c. Macintosh OS X changed the standard locations of some menu items from previous versions. In particular, the “Quit” and “About” items are now in a new menu having the same name as the application (STAT, in this case). This menu appears immediately to the left of the “File” menu. On Windows systems, where there is no equivalent of the “STAT” menu, “Exit” (rather than “Quit”) appears on the “File” menu and “About” is on the “Help” menu.
2.1 Importing Data

Initially, as seen in Figure 3, the only menu options available are “New Data Set...” and “Open Data Set...” in the “File” menu. The former allows a new database to be created by importing data contained in a text file; the latter opens an existing database.

![Figure 3. File Menu](image)

2.1.1 Creating a New Data Set

Selecting “New Data Set...” opens a dialog box in which the user enters a description of the test or simulation in question. The file format must be chosen from the “Format” popup menu before any other actions can be performed. Clicking on the “Select File” button then brings up the operating system’s standard file open dialog and allows the user to select the desired input file and this file name then appears in a (non-editable) text box for reference. For most file formats, information must be entered into each field in the dialog before the “Done” button is activated (only the ignition time is critical; other fields may be filled in with any information that is meaningful to the user). However, the MSU GUI format does not require an ignition time because, for FSSIM simulations, the time always starts at zero.

During the import process, a new column for elapsed time (in seconds) is inserted immediately after the clock time column\(^4\). Note that the ignition time is used to determine the elapsed time, which is used in the calculation of pre-ignition background values, so it is important that the ignition time entry be correct. The initial page is always labeled “Raw Data” and, to prevent corruption of the original data, this page can not be edited — instead, selected data are copied to new pages where they may be processed.

It is important to realize that, when a new data set is created, the data are stored in a temporary file on the hard disk and that this file is deleted when the user quits the application. Changes that the user makes (new configuration information or data processing, for example) are also stored into this temporary file. Data are only transferred to a permanent file when the user manually saves the file. This means that, if a mistake is made, the user can close the file without saving changes and revert to the last saved version.

\(^4\) Some import formats do not have a clock time column. If absent, this column will be blank.
2.1.2 Appending to a Data Set

Because a single data set may be composed of multiple files, and the same channel numbers may be used in more than one of those files, STAT appends a letter suffix to each channel number to distinguish among the different files. Thus, channel “1” from the first file will be labeled “1A” while that from the second file will be “1B” and so forth for additional files. The “Append Data Set...” item in the “File” menu becomes active after the initial data import so that additional data may be appended.

2.2 Defining Test Configurations

After one or more data files have been imported, the “Configuration” menu (Figure 4) becomes active. This is used to define the channel configurations that are of interest. Note that it is not necessary to define all channels from the test or simulation, only those that are needed for data analysis.

The channel configurations must be made prior to any data analysis because the analysis functions use the configuration information to select the columns that are to be processed. Accordingly, items in the “Data” menu remain disabled until the configuration has been completed.

2.2.1 Editing Lists

In creating a new configuration, the first step is to edit the key word lists. These provide the names of compartments, sensors and engineering units that will appear in popup menus in subsequent dialogs. By using a single master list for each type of key word, we avoid problems that could be caused by typographical errors. The key word lists may be created and edited in any order, but all three must be created before any instruments or channels may be configured.

In the list editor dialog, you must click on the “Add” button to add a new item to the list. To edit an existing item, select it (the “Delete” button becomes active) and make any desired changes (the “Delete” button becomes a “Change” button). Clicking on the “Done” button will save the list and make the changes permanent; clicking “Cancel” at any time will discard all changes made during the current editing session. In either case, the dialog will close.
2.2.2 Configuring Instruments

Selecting “Configure Instruments...” opens a dialog box that allows the user to define an instrument name and associate a specific sensor and engineering units with that instrument. The separation of the instrument definition from the key words means that sensors and units may be combined in various ways to define different instrument types. For example, temperature measurement instruments might be defined using different sensors, such as thermocouples and resistive temperature devices (RTDs); some might be calibrated in kelvins, others in degrees Celsius. To simplify this process, instrument names are entered into text fields while the sensors and units are chosen from popup menus containing the previously created key word values. Instruments are added, deleted or edited using the same set of buttons as used for key words.

There is also a “Time Delay” checkbox in the dialog which may be used to indicate that data from this type of instrument are delayed relative to the elapsed time values, as is often the case for gas analyzer data. At present, the checkbox value is stored with the instrument configuration definition but is not used elsewhere. It is a placeholder for a future capability that will allow the data analysis routines to correct for transit delays associated with gas analyzer data.

2.2.3 Configuring Channels

After instruments have been defined, the “Configure Channels...” menu item must be used to set up the individual channels. The channel configuration dialog displays the current channel sequence number, total number of channels and the label and status of the current channel. Note that the sequence numbers run consecutively from one to the total number of channels while the label field shows whatever channel numbering existed in the original input data. There are navigation buttons to move to the first, previous, next or last channel; there is also a “Go to Seq. Number” option to jump directly to a sequence number. After using the jump feature, the user should check the label field to verify that the expected channel is displayed.

Using popup menus similar to those discussed previously, the user specifies the instrument type and the compartment in which it is located. The exact position within the compartment may be entered (this information is saved with the channel data, but is not presently used — like the time delay checkbox, it is a placeholder for future functionality). The dimensional units are chosen from a popup menu but, unlike the key words, the values on this list (meters and feet) are pre-defined and can not be changed by the user. In the case of an instrument that has been defined as having a time delay, a value must be entered into the time delay field (in seconds) before the configuration can be saved (the default delay is zero seconds).

For a channel that has not yet been configured, the status field displays “Invalid” and only the “Cancel” button is active. After all of the required information has been entered, the “Change” button is enabled. Clicking on that button updates the configuration of the displayed channel and the status field then reads “Changed.” Moving to a different channel without clicking the “Change” button will discard any changes that had been made.

Normally, moving from one channel to another causes the values associated with the new channel to be displayed. The “Remember Values” checkbox allows this behavior to be

8
 overridden if the new channel has not been configured. In this case, rather than clearing all channel information and displaying null values (which are the “current” values for all channels that have not yet been initialized), the values from the preceding channel are retained but are displayed in italics as a reminder that they don’t reflect the actual values for the channel. This is a convenience when multiple channels need to be configured with similar values — rather than entering all of the information again, only that which is different from one channel to the next needs to be entered.

When a configured channel is displayed, the status field shows “Unchanged” and the “Clear” button will be active so that the channel may be reset to the uninitialized state. Clicking the “Cancel” button at any time closes the dialog and reverts the configuration to that which existed before the dialog opened. To save the edits, you must click on the “Done” button, which will update the data file and close the dialog box.

Once a set of configuration parameters (key words, instruments and channels) has been defined, that configuration may be saved as a separate file by using the “Export Configuration..” command. The output is an extensible markup language (XML) text file, which can be imported and applied to other data sets. It is also human-readable, although somewhat confusing due to the linkages among the various entries.

A portion of a configuration file is given in Listing 1 as an example. Note the use of fields such as “CmptID” to link key words, instruments and channels. This allows entity names to be changed without affecting the relationships among the various entities. For example, the first instrument (InstID=1) is defined as using SensorID=14, which corresponds to a type K thermocouple (from the key word section). If this were found to be in error, the sensor name could be corrected (e.g., to an RTD sensor) and the definition of the instrument would automatically inherit the new sensor name.

When importing a configuration, warnings are issued if there is a mismatch between the number of channels defined in the file and the number actually present in the data set or if a configuration already exits. Importing a configuration file will replace any pre-existing configuration, so the latter warning is important. Of course, even if the different data sets do not have exactly the same configuration for all channels, the information from one test or simulation can be imported and edited, avoiding the need to start over for each data set.

2.3 Processing Data

Data processing is accomplished by using commands from the “Data” menu, shown in Figure 5. As mentioned earlier, to protect the integrity of the data, no processing is permitted on the “Raw Data” page. Instead, selected data are copied to a new page\(^5\) where further processing may be done. Therefore, when the “Raw Data” page is active, only the “Select” item is available in the “Data” menu.

---

\(^5\) There is an option to move the data to an existing page, but this function has not yet been implemented.
Listing 1. Excerpts from a Configuration File

The configuration file, in XML format, has components describing the keywords, instruments and channels, as well as version information so that changes can easily be made to support new features in future releases of STAT. Note that the various xxxID values link the parts of the file, as discussed in the text.
2.3.1 Selecting Data

Using the “Select...” command, the user may choose specific channels, based on the compartment and type of instrument, for further analysis. There are checkboxes that enable selection by compartment, by instrument or both. When either box is checked, the corresponding popup menu becomes active, allowing a specific compartment or instrument to be chosen. If a box is left unchecked, then all compartments or all instruments, as appropriate, will be included in the selection. However, at least one of these boxes must be checked — leaving both unchecked is equivalent to selecting everything, which would defeat the purpose of making a selection.

2.3.2 Filtering Data

After data have been selected and copied to another page, additional processing options become available. The “Filter...” command allows the user to remove bad data or outliers from a selected subset of the data on the current page. Data may be selected by compartment or by instrument and data from the selected channels may be filtered based on minimum value, maximum value or deviation from the local mean value. For the latter, both the width of the averaging window and the maximum standard deviation may be set. The width is constrained to odd numbers greater than or equal to three in order to ensure that there is a central point to which the mean many be compared.

Data are first processed to identify values that lie outside of the specified minimum and maximum. A sliding window average is calculated for the points that pass this first cut and those that exceed the maximum deviation are flagged on the second pass. Data which fail on any of the criteria will be flagged (displayed in red) but are not removed from the set or altered. The effects of the filter may be reversed by selecting the “Clear Filter...” command. This command, which is applied to the subset of the data specified by the compartment and instrument, removes the flags and resets the display color to black. Filtering may then be repeated, using different parameters.

2.3.3 Normalizing Data

The “Normalize...” function is intended to correct for zero-offset errors in the various channels. This function has two modes: a mean value mode that corrects for systematic difference between nominally identical instruments and an absolute value mode that adjusts instrument outputs to a known value. The former is useful when there are multiple instruments (thermocouples, for example) giving different readings and the actual value of the parameter (air temperature, in this case) is not known. If the correct value is known (as it often is for oxygen or carbon dioxide concentrations), then the absolute value mode should be used.

In either case, all of the pre-ignition data (i.e., the data corresponding to negative elapsed times) are separately averaged for each column, on the assumption that the compartment was approximately at equilibrium during the period prior to ignition. If the mean value mode is used, a target value is calculated as the ensemble average of all of the columns during the pre-ignition period. When the absolute value mode is used, the target value is provided by the user. The data that contribute to the mean value calculation for each column are displayed in blue.
For each instrument, the offset between the column’s pre-ignition mean and the target value is calculated; that offset is then used to adjust the data for the duration of the test. This has the effect of normalizing the specified channels so that they report the deviation from the pre-ignition value.

As in the case of data filtering, popup menus may be used to choose a subset of the data to be normalized. Also, there is an “Honor filter” option so that all data points that were flagged by the filter operation may be excluded from consideration during the calculation of mean values.

2.3.4 Smoothing Data

The “Smooth...” menu item allows the user to apply a sliding window average, of specified width, to a selected subset of the data. As in the case of the filter dialog, the width of the sliding window must be odd and at least equal to three. Unlike the filter function, the smooth function does change the data values — the central point is replaced by the average of the values in the window. Smoothing is performed in two passes so that processed and original data values are not mixed. Like the normalize function, the “Honor filter” option excludes filtered data from processing.

2.4 Data Output

After data on a given page have been processed, they may be exported, using the “Export Data” command on the “File” menu, for plotting or additional processing with other software. The user may select either a tab- or a comma delimited text format and, optionally, values that were flagged by the “Filter” command may be replaced with a user-specified text string. The default replacement text is the empty string.

2.5 Example Data

As mentioned above, a set of sample data is included on the STAT 2.0 distribution CDROM (Appendix A). The original data, from test 11 in series 1A of the Hydraulic Fire Hazard program [3], are provided in “Example Data A.txt” and “Example Data B.txt.” Both files are in the MassComp tab-delimited format and the “Example Config.xml” file contains configuration information from the test. The file “Example.sdb” is a database containing some processed data.

The test was conducted on 7 August 2003 and the ignition time was 12:03:10. The latter value should be used when creating a new data set.
PART II       MENU COMMANDS

In Part II, we discuss the details of all STAT menus and their corresponding dialog boxes. Each menu is the subject of a separate section, presented in the order (left to right) in which the menus appear on the menu bar.

3.0                     STAT MENU (Macintosh only)

The “STAT” menu, which exists only on the Macintosh platform, is shown in Figure 6. It contains only two items that are specific to the STAT application: “About STAT...” and “Quit STAT.” All of the remaining menu items are system-provided commands. For Windows, the “About STAT...” command may be found on the “Help” menu and “Exit” (the equivalent of “Quit”) is on the “File” menu. This is consistent with the user interface standards for these two platforms.

![Figure 6. STAT Menu](image)

The STAT menu exists only on the Macintosh OS X operating system and contains menu items for displaying the “About” dialog and for quitting the application. All other items on this menu are standard items provided by the operating system. On Windows, the “About STAT” command is in the “Help” menu and the “Exit” command is in the “File” menu.

3.1                     About STAT...

This menu item displays a dialog (Figure 7) that contains copyright and version information for the STAT program.

3.2                     Quit STAT

The “Quit STAT” command quits the application and, if there are unsaved changes to the data set, gives the user a chance to save the changes, cancel the quit action or quit without saving. For Windows, the equivalent “Exit” command is located in the “File” menu.
The “About” dialog displays copyright and version information for the STAT program.

### 4.0 FILE MENU

The Windows “File” menu (bottom) differs from the Macintosh “File” menu (top) by the addition of an “Exit” item. This corresponds to the Macintosh “Quit” command in the “STAT” menu.
The “File” menu, shown in Figure 8, provides standard file manipulation commands, including commands for opening or creating a new data set, appending additional channels to an existing data set, saving the data set and exporting processed data. Printing commands are not included — it is assumed that data will be exported and post-processed with other software (graphics programs, for example) and that any required printing of the numerical data can be accomplished at that time.

4.1 New Data Set...

The “New Data Set..” command displays the dialog box shown in Figure 9. A format must be chosen from the popup menu before any other fields are enabled. The currently available formats are described in Table 1. The “MassComp (translated)“ format is essentially obsolete, but was retained due to the amount of data that has been archived in that format.

![Figure 9. New Data Set Dialog](image)

<table>
<thead>
<tr>
<th>Format</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>LabVIEW</td>
<td>This is the format currently used by the ex-SHADWELL LabVIEW data acquisition system, which replaced the old MassComp system.</td>
</tr>
<tr>
<td>MSU GUI</td>
<td>Used by the Mississippi State University graphical interface for the FSSIM fire model.</td>
</tr>
<tr>
<td>MassComp (tab-delimited)</td>
<td>A tab-delimited export of the MassComp data.</td>
</tr>
<tr>
<td>MassComp (translated)</td>
<td>The format produced by the original MassComp “Translate” utility. This is nominally a fixed column width format, but the spacing of some columns is inconsistent.</td>
</tr>
</tbody>
</table>

Table 1. Available Import Formats

The “Select File” button brings up a standard file open dialog, from which the data file may be selected. After the selection is made, the name of the file will be displayed in the adjacent text box. This field is non-editable — to change the file, use the “Select File” button again.

Note that all of the file formats are various text types and can not be readily distinguished by the operating systems. As a result, it is possible to choose a file that has a data organization different
from that implied by the user’s selected format. The results are undefined but, in general, it should be expected that the data will be scrambled during the import process. In that case, it will be necessary to close the corrupted data window and start over with the correct input file.

The “Done” button will not be enabled until a format and file have been selected and all active text fields have been filled in. For the MSU GUI format, there is no clock time column and the elapsed time always starts at zero. Therefore, the “Ignition” field is not used when this format is specified. For the other formats, where it is necessary to determine which data correspond to the pre-ignition period, it is important that the ignition time be correctly set. The other fields are only descriptive and may be filled with any information that is meaningful to the user. Clicking the “Cancel” button at any time will close the dialog without importing any data.

4.2 Append Data Set...

The “Append Data Set…” menu item displays the same dialog box but, in this case, all of the fields, except the file selection, are already filled in with the original data. After selecting the file, the “Done” button will be activated and the data may be imported. Clicking on the “Cancel” button will close the dialog without appending any data.

4.3 Open Data Set...

“Open Data Set…” displays the standard file open dialog and allows an existing data set file to be opened. These are databases identified by the “sbd” file extension. The behavior of STAT when attempting to open a file that is in some other format is undefined and could crash the application.

4.4 Close

“Close” closes the current data set file. If there are any unsaved changes, a prompt will appear and provide options to save the changes (the default), cancel the close or close without saving changes.

4.5 Save

The “Save” menu item uses a “safe save” method to update the permanent data file with a copy of the temporary data file while guaranteeing that the file is not lost if a failure occurs during the process. “Save” is available whenever a data set is open and has unsaved changes. This command is only available after a permanent file set has been created using the “Save As…” command (below).

4.6 Save As...

Prior to the first use of this command, the data set exists only as a temporary file that will be deleted when the data window is closed. Using “Save As…” creates a permanent copy of the data set, with a user-specified name, at the location chosen by the user. “Save As” is available whenever a data set is open and may be used to save the file to a different name or location.
4.7 Export Data...

“Export Data...” opens the dialog shown in Figure 10. The radio buttons allow selection of either of two text export formats: tab-or comma-separated\(^6\). In either case, values that were excluded by the filter function may optionally be replaced by a user-specified string. By default, the empty string is used as the replacement.

![Figure 10. Export Data Dialog](image)

4.8 Exit (Windows only)

The “Exit” command quits the application and, if there are unsaved changes to the data set, gives the user a chance to save the changes, cancel the quit action or quit without saving. On Macintosh systems, the equivalent “Quit” command is located in the “STAT” menu.

![Figure 11. Edit Menu](image)

In order to maintain data integrity, manual editing using cut and paste methods is not permitted. The “Clear Selection” command, available only when a data column is selected, allows the column to be deselected but does not change the data.

---

\(^6\) The comma-separated values format is frequently referred to as “csv” format, after the commonly used file extension for this type.
5.0 EDIT MENU

In order to ensure that the window properly displays the results of the applied data processing functions, none of the standard editing methods are allowed and, in this version, “Undo” is not supported. Accordingly, the “Undo,” “Cut,” “Copy” and “Paste” items in the “Edit” menu, shown in Figure 11, are disabled.

5.1 Clear Selection

If a column has been selected (i.e., the cells are highlighted). “Clear Selection” is used to reset the column to the unselected (not highlighted) state. The data in the selection are not affected.

6.0 DATA MENU

The “Data” menu (Figure 12) provides the core functionality for the STAT program, including the ability to select subsets of the data, detect outliers, normalize channels and perform data smoothing.

6.1 Select...

The “Select...” command allows a subset of the data on the current page to be chosen. It displays a dialog box, shown in Figure 13, that requires the choice of one or both of the “By compartment” and “By instrument” selection criteria. If neither of these boxes has been checked, the “Select” button will not be enabled. If one box is left unchecked, then all compartments (or all instruments, as appropriate), will be accepted. When a box is checked, the corresponding popup menu is enabled so that a single compartment or instrument may be selected. These two criteria are ANDed together (i.e., a channel is not selected unless the channel configuration matches both the specified compartment and the specified instrument type).
Selections are only made from the currently displayed page and, if no columns match the given criteria, an error message will be displayed. If there are matching data, they will be copied to a new page, which may be given any desired name. The option to copy data to an existing page is not available in this version of STAT.

6.2 Filter...

The “Filter...” dialog (Figure 14) provides a mechanism for excluding bad data points prior to processing. The filter may be applied to subsets of the data on the given page and points may be excluded on the basis of either absolute or relative values. Points that exceed the specified thresholds are flagged and displayed in red but are not removed or altered. This allows the user to see the effects of different filter criteria and easily revert to the original data if the results are not as desired (see section 6.3 for more details).

The data subset that is to be filtered is specified by selecting the desired compartment or instrument from the popups; this is similar to the method used in the “Select” dialog, except that the “All” radio buttons allow explicit selection of all compartments or all instruments.

The absolute value options (“Exclude values less than” and “Exclude values greater than”) permit filtering of values which are greater than a specified maximum or less than a specified minimum. This is intended to be used for cases in which the user knows, a priori, that certain
ranges of values represent bad data. For example, values corresponding to open circuit or short circuit transducers can immediately be removed from further consideration.

![Filter Dialog](image)

**Figure 14. Filter Dialog**

The “Filter” dialog permits “bad” data to be detected and flagged based on any combination of absolute value (the first two checkboxes) or statistical (the third checkbox) conditions. Note that several different filters may be applied to each data page by using the popup menus to specify different subsets of the data.

The relative value options (“Exclude outliers”) performs a sliding window average and determines whether the central point in the window is greater than a specified number of standard deviations from the window mean. The window width is constrained to odd numbers\(^7\) to ensure that there is always a central point.

For a set of values \(\{X_1 - X_N\}\) and a window width, w, the sliding average is given by

\[
\bar{X} = \frac{1}{w} \sum_{i=1}^{w} X_i \quad \text{Eqn. 1}
\]

where the summation limits for Equation 1 are given by

\(^7\) The minimum window width is three points since a single point would mean no averaging was performed.
\[ l = \begin{cases} 1 & (j-w' < 1) \\ j-w' & (j-w' \geq 1) \end{cases}; \quad \text{Eqn. 2} \]

\[ u = \begin{cases} j+w' & (j+w' \leq N) \\ N & (j+w' > N) \end{cases}, \quad \text{Eqn. 3} \]

and the window half-width is

\[ w' = \frac{(w-1)}{2}, \quad \text{Eqn. 4} \]

\( n \) is the number of \( X_i \) values in Equation 1 which are numeric and lie within the range defined by the user-specified minima and maxima and \( N \) is the index of the last element of the set.

The standard deviation for the window is calculated as

\[ \sigma = \frac{1}{(n-1)} \sum_{i=l}^{u} (X_i - \bar{X})^2 \quad \text{Eqn. 5} \]

This function is useful, for example, in cases where there are significant spikes which may, or may not, represent valid data. Both the width of the window over which averaging is performed and the threshold deviation from that average can be set by the user.

If either “Exclude values less than” or “Exclude values greater than” is checked, then the corresponding text box becomes active. An appropriate numerical value must be entered or the “Filter” button will not be enabled.

When “Exclude outliers” is checked, the standard deviation and window width up- and down-arrow controls are active. The standard deviation threshold can be set in increments of 0.1. Similarly, the window width is adjustable in two-point steps with a lower limit of three points.

Note that there is a subtle distinction between absolute and relative value filtering. In the former, data which exceed the user-specified limits are assumed to be invalid. Accordingly, they are immediately excluded and are never used in any filter calculations. In particular, they have no effect on the sliding window average. For the relative value case, all data are assumed to be valid until they fail the statistical test. This means that they are included in the calculation of the window average and, therefore, can affect the decision as to whether other points should, or should not, be excluded.

6.3 Clear Filter...
“Clear Filter...” is enabled if any data on the current page has been filtered. The dialog box (Figure 15) has controls, identical to those in the filter dialog, for choosing a subset of the data. Clicking on the “Clear” button causes the results of the previous filter operation to be undone, resetting the specified data to the unfiltered state. “Clear Filter” is useful if the previous filter was determined to have been too strict or too lenient and the user wishes to start over with other parameters.

6.4 Normalize...

The “Normalize...” dialog allows correction of instrument zero-offset errors. As shown in Figure 16, it includes the same controls as “Filter...” and “Clear Filter...” for selection of a subset of the data. The radio buttons in the lower section permit the selection of either mean value or absolute value mode. The former adjusts the offset of each selected channels so that the pre-ignition mean value for that channel is equal to the ensemble pre-ignition mean value of all channels that meet the selection criteria. In the latter mode, offsets are adjusted so that the pre-ignition mean of each selected channel is equal to a user-specified value. If “Honor filter” is checked, then values flagged by the “Filter...” command are not included in calculating the pre-ignition means.

Mean value mode is typically used if there are several instruments of the same type and the actual value of the measured parameter is not known \textit{a priori}. Note that this mode requires that there be at least two columns in the selected data subset. The absolute value mode is appropriate if the correct value is known. This method can be used even if there is only one column in the selection.
For example, there may be a large number of thermocouples, each giving a different reading, in the same compartment. In this case, it may be reasonable to assume that, prior to ignition, the space was approximately isothermal at some unknown compartment temperature. Using the mean value option, all of the thermocouples will be adjusted so that their individual pre-ignition means are equal to the compartment’s ensemble average temperature for the pre-ignition period.

Typically, it may be assumed that the pre-ignition atmospheric composition is homogeneous and it is often reasonable to also assume that the species concentrations are those of normal air. In this case, it would be appropriate to select the absolute value method and to specify standard values for oxygen, carbon dioxide or carbon monoxide concentrations, as appropriate.

6.5 Smooth...

“Smooth...” performs a sliding window average, as was done by the “Filter...” command. However, “Smooth...” replaces the center point in the window with the window’s average value. The dialog box (Figure 17) has the same data selection controls discussed above and the “Honor filter” checkbox behaves as described in section 6.4.

To ensure that raw data and mean values are not mixed when performing these calculations, this function processes the data in two passes. In the first pass, mean values are calculated from raw data and stored in a temporary array and, during the second pass, the smoothed data are copied back to the data window.

Figure 16. Normalize Dialog
7.0 CONFIGURATION MENU

The “Configuration” menu, shown in Figure 18, provides commands for setting up key word lists, defining instruments and associating channels with the corresponding instrument and location. There are also commands for exporting new or updated configurations and for importing previously saved configurations.

7.1 Edit Lists...

STAT uses three user-configurable key word lists: compartments, sensors and engineering units. The purpose of these lists is to ensure that key words are only defined once, which is a central tenet of database design. This eliminates the problems that would ensue if, for example, search terms (such as compartment names or instrument types) were defined in different places with different spellings. It also allows the values of the key words to be segregated from the actual search parameters used within the database. Thus, the spelling of a key word can be corrected without affecting the results of previous searches that may have used the misspelled version. This
is accomplished by assigning a permanent record identifier when a key word is initially defined and using that identifier for all searches.

The “Edit Lists...” dialog (Figure 19) includes tabs for each of the three key word categories and, within each category, the controls are identical. Initially, all of the lists are empty; after entering a string in the text box, the “Add” button becomes active and, if pressed, the entry is appended to the list. None of the three lists are actually saved until the “Done” button is clicked.

![Figure 19. Edit Lists Dialog](image)

If an existing list item is selected from the popup menu, the “Delete” button is enabled so that the item may be removed from the list (the “Add” button remains inactive — items can not be added again). The selected item may also be edited, in which case the “Add” button becomes enabled and the “Delete” button is changed to a “Change” button. This makes it possible to either create a new item by editing an existing one or to change the value of the existing item to the edited value.

Each of the three lists is used to create popup menus that appear in one of the other configuration dialogs, so it is necessary to have at least one value in each key word list before the “Configure Instruments” or “Configure Channels” menu items are enabled.

7.2 Configure Instruments...

Instruments are defined in the “Configure Instruments...” dialog, shown in Figure 20. Like the key word editor, this dialog has an initially empty list which can be added to, deleted from or edited as discussed above. It also has two popup menus that are populated with the previously defined compartment and engineering unit key words. In addition to providing a name for the instrument, the user must also specify the type of sensor and the engineering units used by that instrument type.

Note that this dialog is used to define a type of instrument, not a specific instrument (the latter is done in the “Configure Channels...” dialog, described below). Also, it allows the user to make a distinction among different applications of the same sensor. For example, rather than defining a “thermocouple” instrument, it would usually be better to define an “air temperature” type, a “bulkhead temperature” type and a “deck temperature” type. This would allow data to be sorted

---

8 These identifiers correspond to the xxxID values that were shown in Listing 1.
and processed differently for each of these applications, even though they all use a thermocouple as the underlying sensor.

![Figure 20. Configure Instruments Dialog](image)

The “Time delay” checkbox allows the user to flag channels which do not provide real-time outputs. This commonly occurs with gas analyzers, for which there is a transit delay due to the length of the tubing in the sampling system. The value of this checkbox is saved with the channel configuration, but is not currently used.

7.3 Configure Channels...

Figure 21 shows the dialog box in which the details of each data channel are specified. Note that, unlike the key word and instrument lists, the channel configuration is not initially empty. This is because there must be one, and only one, configuration for each column of imported data. To ensure this, the initial channel configuration list is created when the data are imported but the list items are populated with null values. The “Configure Channels...” dialog is designed not to create a new list but to edit an existing list.

Status information for the currently displayed channel is shown at the top of the dialog and the channel configuration is entered using the popup menus and text fields in the center area. The lower portion contains channel navigation controls and the standard editing controls.

![Figure 21. Configure Channels Dialog](image)
The “Seq. Number” is the index of the array element in which the channel information is stored and is sequential from one to the total number of channels in the data set (this is determined during the initial data input and is updated if additional data are appended). If the channel numbers in the input file are not sequential, it is easy to become confused while navigating through the channel list. Accordingly, the “Label” field was included to show the channel label (the first row of the imported data). This makes it easier to verify which channel is being displayed.

Initially, the status will be “Invalid” to indicate that no channel configuration has been specified. If the channel in question has previously been configured, the status field will read “Unchanged” to indicate that the channel is valid and that there have not been any changes to that channel during the current editing session.

After entering the required information, the “Change” button will be enabled; clicking on that will update the channel list in memory and change the status field to “Changed” to indicate that the channel configuration has been altered in the current editing session and that those changes have not yet been saved. Moving to another channel without clicking the “Change” button will discard any changes that might have been made to the current channel.

The “Done” button must be used to save the changes and close the dialog. Clicking on “Cancel” at any time will also close the dialog, but all of the changes made during the editing session will be discarded.

The “Clear” button resets the currently displayed channel to the default (no configuration) state; the status will revert to “Invalid” — this is essentially the same function as was performed by the “Delete” button in the other configuration dialogs except that the list entry is not removed, it is only set to contain null values.

Normally, when moving from one channel to another, all of the popups and text fields are set to the values of the newly-displayed channel. However, when initially setting up a configuration, almost identical information often has to be entered into consecutive channel configurations. In order to avoid having to enter the same information repeatedly, the “Remember values” checkbox was added. If this is checked, the values from the previous channel are retained when moving to a new channel (they are displayed in italics as a reminder that they do not represent the actual values for the channel) so that only a few items will need to be entered.

The navigation buttons in the lower left area permit the user to jump to the first or last channel and to move forward and backward, one channel at a time. The “Go to Seq. Number” controls allow jumps directly to an arbitrary sequence number (not to an arbitrary channel label).

7.4 Import Configuration...

The “Import Configuration...” command displays a file open dialog that allows the configuration from a previous test to be reused. If a configuration has been defined for the current data set, a dialog will be displayed to warn that the existing configuration will be overwitten by the new
one, providing an opportunity to cancel the operation. There will also be a warning if the current data set and the configuration file have different numbers of channels.

7.5 Export Configuration...

“Export Configuration...” opens a file save dialog box so the current configuration information can be saved. The output is a text file based on the extensible markup language (XML) standard. It is optimized to be machine readable, but can be opened and displayed in any text editor (see Listing 1 for an example).

8.0 HELP MENU

![Figure 22. Help Menu](image)

Figure 22. Help Menu

The “Help” menu is empty on Macintosh but contains the “About STAT” command on Windows. This command is located in the “STAT” menu on Macintosh.

For Windows, the “Help” menu (Figure 22) contains the “About STAT...” menu item. On Macintosh, this menu is empty and the “About STAT...” menu item is in the “STAT” menu. This is consistent with the user interface standards for these two platforms.

8.1 About STAT... (Windows only)

This menu item displays a dialog (see Figure 7) that contains copyright and version information for the STAT program.

9.0 REFERENCES


ACKNOWLEDGMENTS

The author would like to thank Joe Strout, of Inspiring Applications, Inc., for his assistance in the resolution of several programming issues, resulting in significantly improved performance of the STAT application.